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Setup Instructions 
• Copy the files in USB flash memory 

– Copy “IIJ_Hands-on” to “C:\” of your laptop (Host OS) 
• leaked_file 

– 7z file including documents leaked during this incident 

• WinHost 
– Data and tools used on host OS 

• WinVM 
– Data and tools used on Windows VM 

• Documents 
– Hands-on PDF and its answer PDFs (password protected) 
– references for forensic investigation 

– NOTICE: “\” stands for backslash in Japanese OS 

• Extract the disk image 
– C:\IIJ_Hands-

on\WinHost\acquired_disk_image\win7usp1.zip 
• Vista and 7 users: Use “Extract all files” of OS function 
• XP users: Install 7-Zip and use it 

– C:\IIJ_Hands-on\WinHost\tools\7z920.exe 

– DELETE the image after your hands-on!! 
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hands-on 
Host OS 



IMPORTANT: Hands-on Mark 
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hands-on 
Host OS 

hands-on 
VM 

Work on something 
in your host OS  

Work on something 
in your guest OS  

Just look 



Scenario 

• You are a member of CSIRT at a certain 
company 

• You were externally-pointed out information 
of your company leaked 
– The leaked private documents were uploaded on 

the Internet 

– The file name is “a.7z” 

• You identified the suspicious PC from the 
following evidences  
– file sharing server’s event logs 

– interview outcome of clients 

• That’s why you decided to examine the PC 
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Client A 
OS: Windows 7 SP1 
user: okita 

Private Network  (192.168.52.0/24) 

Client B 
OS: Windows XP SP3 
user: kondo 
(network admin) 

Client C 
OS: Windows Vista 
SP2 
user: toshi 
(executive) 

File Sharing / web 
Server 
OS: Windows 
Server 2003 r2 SP2 

DC/ Internal DNS 
Server 
OS: Windows 
Server 2008 r2 SP1 

External DNS 
/Mail/Firewall/ 
GW(mail) 
Cent OS 6 

The Internet 

.32 

.50 .52 .51 .34 .33 

Domain : shinsen-group 

Network Configuration 
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The file server was accessed 
from Client A using toshi 

(executive) account. 
Okita never knows the 

password. 



Flow of Incident Response 

Forensic Analysis Malware Analysis 
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Hands-on 
Exercises 



Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
 

8 



Timeline Creation 
• Create Timeline using log2timeline on SANS SIFT Workstation 

– Put together various timestamps (e.g., filesystem, registry) into one 
output form 

• Narrow down time period of malware infection by using some 
information 
– Find malware infection signs (e.g., start-up locations, execution 

history caches) 
– Use external information (e.g., malicious URLs, IPS logs) 

• Check the time period 
– Trace back from the period for infection root cause 
– Follow malicious activities after the period  

log2timeline 

Filesystem 

Registry Hives 

Web History 

Program Execution 

output collected results  

in CSV format 
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Timeline Creation(Cont.) 
• log2timeline-sift on SANS SIFT Workstation 

– Creation 
• log2timeline-sift -win7 -z Japan –i path_to_the_image_file 

– If “Share Folders” is enabled, you can specify the image file in the 
host OS’s folder 

• e.g, /mnt/hgfs/Host-Computer-C-Drive 

• Check cheatsheet for details like command line options 
– C:\IIJ_Hands-on\Documents\log2timeline-cheatsheet.pdf 
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Timeline Creation(Cont.) 
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• log2timeline-sift on SANS SIFT Workstation 
– filter by date range 

• l2t_process -b /cases/timeline-output-
folder/ImageFileName_bodyfile.txt  

 StartDate (..EndDate) > path_to_output_CSV 

 

 



Timeline Creation(Cont.) 

• log2timeline-sift on SANS SIFT Workstation 
– Check source types of entries extracted from CSV 

• awk -F, ‘{print $6;}’ path_to_the_csv_file | grep -v 
sourcetype | sort | uniq 

– v2.13 drops event log entries! 
• due to Japanese OS image? 
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Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Checking automatic start-up programs 

• malware adds its automatic start-up setting 
in order to run after reboot or logon 
– Checking the configurations is one of the most 

effective methods to detect malware 

• AutoRuns 
– Display all-in output of startup settings 

• e.g., registry Run keys, services, BHOs, etc.. 

– Not only live systems, but offline system 
volumes can be examined 
• Use “Analyze Offline System” function  

• FTK Imager 
– Mount disk images with read-only 
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Hands-on#1: Checking automatic start-up 
programs 

• FTK Imager 
– Install 

• C:\IIJ_Hands-
on\WinHost\tools
\AccessData%20F
TK%20Imager.exe 

–  [File] -> [Image 
Mounting...] 
1. Specify the 

image file path 
2. Mount 
3. Check Mapped 

Images 
– What’s the drive 

letter? 
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Volume Letter = E 
(The letter may be 
different in your PC) 

① 

② 

③ 

hands-on 
Host OS 



Hands-on#1: Checking automatic start-up 
programs (Cont.) 

• AutoRuns 
– Extract "C:\IIJ_Hands-on\WinHost\tools\Autoruns.zip“ 
– Run autoruns.exe as administrator 

• Check the window name (admin user name is displayed?) 

– Select [Options] -> [Filter Options] to reduce some noise 
– [File] -> [Analyze Offline System...] 

1. System Root = Mounted_Image_Volume_Letter:\Windows 
2. User Profile   = Mounted_Image_Volume_Letter:\Users\okita 
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① 

② 

hands-on 
Host OS 

Check your volume  

letter in FTK Imager 



Hands-on#1: Checking automatic start-up 
programs (Cont.) 

• Question 
– Can you find the entry of a suspicious 

executable file in the result of AutoRuns? 
• the registry path and file path 
• why suspicious? 

• Hints 
– The system is Windows 7 SP1, UAC enabled 

• Focus on user settings (e.g., HKCU) first 

– Most Microsoft binaries are not signature-
verified unless the offline OS version is 
identical with your live OS version 
• Skip the Microsoft entries for now 
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hands-on 
Host OS 



Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Identifying Malware Installation Time 

• We found suspicious registry entries  
• Registry keys include last written 

timestamps 
– For root cause of malware infection, we can 

trace back timeline based on the timestamps 

• Registry File Extraction 
– Digital Forensic Framework 

• Parse disk images, then browse/display file 
content including deleted/unallocated space 

• Registry Analysis 
– Registry Decoder 

• Parse registry files, then brose/search the 
keys/values/data 
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Hands-on 2 



Registry File Extraction 

• Digital Forensic Framework on SIFT 
– Click DFF icon on SIFT menu bar 
– [File] -> [Open evidence file(s)] 
– Specify ①RAW format, ②image file path 
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① 

② 



Registry File Extraction (Cont.) 

• Digital Forensic Framework on SIFT 
– Parse NTFS filesystem using “Relevant module” 

• [Relevant module] -> ①partition, ②ntfs 
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① 

② 



Registry File Extraction (Cont.) 

• Digital Forensic Framework on SIFT 
–Extract the registry file 

•Save it to Host OS’s folder 
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Hands-on#2: Registry Analysis 
• Registry Decoder 

– Extract "C:\IIJ_Hands-on\WinHost\tools\regedcoderR103.zip“ 
– Run regdecoderR103.exe 

• Select [Start a new case] and Next 
• Create Case 

– Case Directory="C:\IIJ_Hands-on\WinHost\tools\regedcoderR103\test” 
should be newly-created!! 

• Add Evidence  
– C:\IIJ_Hands-on\WinHost\exported_registry_files\okita\NTUSER.DAT 
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Create Case 
Add Evidence 

hands-on 
Host OS 

The folder should be 

empty or crash!! 



Hands-on#2: Registry Analysis 

•Question 

–Check the last written time of 
the registry key including the 
suspicious registry values 

–How? 
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hands-on 
Host OS 



Hands-on#2: Registry Analysis 

• Hints 
– Use Registry Decoder’s Browse function 

1. Select [File View] tab, then click [View] 
2. Select opened [Browse] tab, then check the 

Run key 

– Use Registry Decoder’s Search Function 
1. Select the registry file in [Search] tab 
2. Input search keyword in [Search Term] text 

area 
– You should extract the keyword from exe file path 

3. Select [Partial Search] if needed 
4. Check all kinds of search targets 

– Keys, Names, Data 
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hands-on 
Host OS 



Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Timeline Analysis 

• Approach to root cause of malware infection 
– Check various timestamps of the suspicious binary for 

validation 
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Registry 
key 

File System Prefetch ShimCache 

Description last written 
time 

MACB times first & last 
run time 

file 
modification 
time 

Tool log2timeline, 
Registry 
Decoder 

log2timeline Windows 
Prefetch 
Parser 

ShimCache 
Parser 

Risk overwritten 
by another 
values 

modified by 
malware 

SSD image ? 
(shutdown 
needed) 

Result 
YYYY/MM/DD 
HH:MM:SS 

2012/10/5 
18:48:30 

2012/10/5  
17:05:56 

not found 2012/10/5  
17:05:56 



Hands-on#3: Timeline Analysis 

• Check timeline generated by log2timeline-
sift 
– Extract “C:\IIJ_Hands-

on\WinHost\timeline\win7usp1-
current\20120901-win7usp1-bodyfile.zip” 

– Open the CSV file with Excel or OpenOffice 
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hands-on 
Host OS 

If deleted, “(deleted)” is added 

modification/last access/entry modified/creation Focus on  

A, B, D, E, F, K columns 



Hands-on#3: Timeline Analysis 
(Cont.) 

• Question 
– Are there any activities before the malware creation 

timestamp? 
• Related to the infection, what files were 

accessed/opened/created? 
– What was the user doing at that time? 

• Hints 
– We have two timestamps 

• File System/ShimCache 
– 2012/10/5 17:05:56 

• Registry Key 
– 2012/10/5 18:48:30 

– In this hands-on, trace back timeline from the earlier 
timestamp only 

• In real case, we should check both of them 

– Check the activities for several minutes from the 
timestamp 
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hands-on 
Host OS 



Other Evidences of User Activities 

• GUI programs executed by the user 
– UserAssist key in NTUSER.DAT 

• number of runs, last run timestamp 

– Registry Decoder’s User Assist plugin 

• Opened files 
– Recently used Office files 

• C:\Users\<user>\AppData\Roaming\Microsoft\Office
\Recent\ 

– JumpList 
• C:\Users\<user>\AppData\Roaming\Microsoft\Wind

ows\Recent 
• JumpLister 

– NTUSER.DAT 
• Shell Bag, RecentDocs, etc.. 
• Registry Decoder plugins（Search is also effective） 
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Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Setting up Windows Guest VM 
• Install VMWare Tools 
• Settings for running malware 

– Change the network connection to “Host-only” 
– If you use VMWare Workstation, take a snapshot for restoration 

• [VM] -> [Snapshot] -> [Take Snapshot] 

– If you use VMWare Player, edit the .vmx file to clear changes after 
power off (See below) 

• C:\IIJ_Hands-on\WinHost\conf\VMWare\Player_Win_setting_En.txt 

• Power-on & logon 
• Create “C:\MalwareAnalysis” folder on Windows VM, and drag 

and drop "C:\IIJ_Hands-on\WinVM“ on host OS into that folder 
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hands-on 
Host OS 

hands-on 
VM 



Dynamic Analysis of Malicious 
Document File 

• Dynamic Analysis 
–Monitor RAM/disk/network activities 

after opening the doc file 
“taiseihoukan.doc” on Windows VM 
•Monitor 
process/filesystem/registry/network 

–Process Hacker/Process Explorer 
–CaptureBAT 

•Emulate fake server 
–FakeNet 
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Hands-on#4: Dynamic Analysis of 
Malicious Document File 

• Set up for dynamic analysis 
– Install Adobe Flash Player ActiveX 

• "C:\MalwareAnalysis\WinVM\tools\flashplayer11_2r202_233_winax_
32bit.exe" 

– Access to a Flash test page using Internet Explorer 
• "C:\MalwareAnalysis\WinVM\tools\flash_IE_test_page\moon.html“ 

– Extract the malware from zip file (Password: “infected”) 
• C:\MalwareAnalysis\WinVM\extracted_malwares\malwares.zip“. 
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hands-on 
VM 



Hands-on#4: Dynamic Analysis of 
Malicious Document File (Cont.) 

• Install CaptureBAT 

–Install 

•“C:\MalwareAnalysis\WinVM\tool
s\CaptureBAT\CaptureBAT.exe“ 

–Restart the VM 
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hands-on 
VM 



Hands-on#4: Dynamic Analysis of 
Malicious Document File (Cont.) 

• Process Hacker 
– Extract  

• "C:\MalwareAnalysis\WinVM\tools\processhacker-2.28-bin.zip“ 

– Run as administrator 
• ArchName\ProcessHacker.exe  

– Check process trees, installed services, network socket status 
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hands-on 
VM 



Hands-on#4: Dynamic Analysis of 
Malicious Document File (Cont.) 

• FakeNet 
– Disable Windows Firewall 
– Extract  

• “C:\MalwareAnalysis\WinVM\tools\Fakenet1.0c.zip” 

– Run as administrator on cmd.exe 
– Check the configuration using nslookup command or web access 
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hands-on 
VM 



Hands-on#4: Dynamic Analysis of 
Malicious Document File (Cont.) 

• Run CaptureBAT 
– After installation, the binary is located at C:\Program Files\Capture 
– Run as administrator on cmd.exe 

• Redirect the output to log file 
• -c: Capture modified and deleted files 

– After running, Check whether Process Hacker reports CaptureBAT 
services are created 

• If you cannot find the message, please check Services tab in Process 
Hacker 
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hands-on 
VM 



Hands-on#4: Dynamic Analysis of 
Malicious Document File (Cont.) 

• Open the doc file 
– taiseihoukan.doc  in 

"C:\MalwareAnalysis\WinVM\extracted_malwares\malwa
res.zip“ 

– Run wmi.exe if Office 2007 is not installed in your VM 
• does NOT work on Office 2003 and 2010  

• If successful, a dummy document will be opened 
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hands-on 
VM 



Hands-on#4: Dynamic Analysis of 
Malicious Document File (Cont.) 

• Questions 
– What’s the malicious hostname and port number 

where the malware tries to connect? 
– Which process adds auto-start settings for the 

malware? 

• Hint 
– Check the results 

• CaptureBAT 
– Press any key to exit 
– Search doc/exe name in the log 

• FakeNet 
– Press Ctrl-C 
– Check the console output 
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hands-on 
VM 



Analyzing Malicious Office 
Documents 

• Checking embedded code/file 
–String search 

•Flash file signatures (“FWS”, “CWS”) 
•JavaScript (“ScriptBridge”), etc.. 

–Parse OLE structure 
•FileInsight 
•Pyew/hachoir-subfile 

• Scanning malicious payloads 
–OfficeMalScanner 

•Detect & extract PE/shellcode/swf 
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Hands-on#5: Analyzing Malicious 
Office Documents 

• You should work in VM, not host OS (See hands-on mark) 
 

• Question 
– Do you think what vulnerability was used for the exploitation of the 

PC?  
• Guess CVE number of this exploit. 

• Hints 
– Notice: The document seemed to include a Flash object 
– Check & extract an embedded object in the Office document 

• FileInsight 
• OfficeMalScanner 

– Decompile the object 
• AS3 Sorcerer 
• Read the decompiled code and guess the vulnerability 
• Find characteristic strings and use search engine (e.g. Google) ;-) 
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hands-on 
VM 



Hands-on#5: Analyzing Malicious 
Office Documents (Cont.) 

• How to use & install tools 
– FileInsight 

• Install  
– "C:\MalwareAnalysis\WinVM\tools\fileinsight.exe“ in VM 

• Run 
– Drag and Drop "taiseihoukan.doc" into FileInsight 
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hands-on 
VM 

Browse OLE structure 
of the document 



Hands-on#5: Analyzing Malicious 
Office Documents (Cont.) 

• How to use & install tools 
– OfficeMalScanner 

• Extract 
"C:\MalwareAnalysis\WinVM\tools\OfficeMalScanner.zip" 

• Run “OfficeMalScanner.exe path_to_doc scan” 
– Search PE/shellcode patterns and extract them 
– Extract SWF file 
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hands-on 
VM 



Hands-on#5: Analyzing Malicious 
Office Documents (Cont.) 

• How to use & install tools 
– AS3 Sorcerer 

• Install  
– “C:\MalwareAnalysis\WinVM\tools\as3sorcerer_setup.exe” in VM 

• Run and drag-and-drop the swf file into AS3 Sorcerer 
• Find characteristic strings and guess the vulnerability 

– Use search engine (e.g. google) 
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hands-on 
VM 



Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Shellcode Analysis 
• Identification by reading decompiled code or p-code 
• extraction from swf file 

– Use hex editor (e.g., FileInsight) 

• emulation (checking APIs) 
– e.g., libemu 
– But, emulation doesn’t work for this shellcode... 

• Debugging  
– binary paste to debuggers or use launcher program 

• http://practicalmalwareanalysis.com/labs/ 

• Static Analysis 
– IDA Pro 
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http://practicalmalwareanalysis.com/labs/
http://practicalmalwareanalysis.com/labs/


Identifying the Malware 
• Open the pcap captured by fakenet using Wireshark 

– The malware initiated communication by sending random 
256 bytes on TCP port 80 of the server 

– PoisonIvy? 
• Camellia Encryption’s challenge-response negotiation 

– https://media.blackhat.com/bh-eu-
10/presentations/Dereszowski/BlackHat-EU-2010-Dereszowski-
Targeted-Attacks-slides.pdf 

– http://labs.alienvault.com/labs/index.php/category/blog/page/3/ 
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What’s Poison Ivy? 

• Poison Ivy is an infamous RAT(Remote Administration Tool) 

• Everyone can download the latest version at a certain web 
site 

 

 

49 

・execute arbitrary code 

・keylogging 

・hijacking mouse/keyboard 

・stealing data MIC/WebCam 

・file download/upload 

and so on ... 

 



Other Traits of Poison Ivy 

• Hidden iexplore.exe 
• PoisonIvy GUI client in VM can be connected from the malware 

– Because Fakenet redirect the connection to localhost 
– The password is default ;-) 

• Quick Analysis using Memory Forensics  
– Redline’s Malware Risk Index (handle name: !VoqA.I4) 
– Code injection activities 
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Analyzing Poison Ivy 
• Unpacking  

– Break VirtualAllocEx/VirtualProtectEx and extract the unpacked PE 

• Debugging  
– Fragmented code injections 

• wmi.exe 
– inject code to explorer.exe 

• explorer.exe 
– install wmi.exe, create iexplore.exe process and inject code to it 

• iexplore.exe 
– connect to Poison Ivy GUI client 

• Static Analysis 
– shellcode-like API resolution 
– position-independent code (e.g., call [esi + *]) 
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Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Result about Root Cause Analysis of 
Malware Infection 

• Exploit 
– The attacker sent an e-mail with .doc file at 

2012/10/5  17:05:10 
– The doc file included a malicious Flash object  
– The object exploited CVE-2012-1535 vulnerability 

• Installed malware 
– Installation Paths 

• Filesystem 
– C:/Users/okita/AppData/Roaming/wmi.exe 

• Registry for automatic start 
– HKCU\Software\Microsoft\Windows\CurrentVersion\Ru

n 

– RAT (Poison Ivy) 
– C&C Server 

• www.fewjriehgusuoh.com 
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See the answer slide 



Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Bonus Hands-on: Tracking 
Attacker’s Activities 

•Question1 

–Examine post-infection activities 

•Is there any tool or exploit used 
by the attacker? 

•When was the tool downloaded? 
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hands-on 
Host OS 



Bonus Hands-on: Tracking 
Attacker’s Activities (Cont.) 

• Hints for Question1 
– Imagine Attacker’s Activities from 

evidences that have been achieved thus 
far 
• a.7z 

– Domain Controller password hash database 
(ntds.dit) was included 

» It means DC was compromised  

• Event logs 
– Different person account was authenticated on 

Client A 
» The acquired password hash may be used 

• What kind of tools did he use for these 
operations? 
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hands-on 
Host OS 



Bonus Hands-on: Tracking 
Attacker’s Activities (Cont.) 

• Hints for Question1 
–Strategies checking timeline 

•check the period after malware 
installation 

•check external information to narrow 
down the time period 

–in this case, “a.7z” 
–check result*.txt 

» suspicious path 
» “C:\Users\okita\AppData\Local\Temp\t” 

» sign of “psexec” execution 
» “\PIPE\psexecsvc” found in “net file” command 

•search “psexec” on timeline 
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hands-on 
Host OS 



Bonus Hands-on: Tracking 
Attacker’s Activities (Cont.) 

• Hints for Question1 
– timestamps changed by the attacker 

• Two kinds of timestamps in NTFS file system 
– Standard Information (SI) Attribute 
– File Name (FN) Attribute 

• If you want to make timeline with FN attribute 
timestamps for yourself, you should change 
log2timeline-sift code 

– http://list-archives.org/2012/07/10/dfir-lists-sans-
org/log2timeline-vs-log2timeline-sift/f/4359338113 
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hands-on 
Host OS 

MFT Header 
Standard Information 

(SI) Attribute 

Filename 

(FN) Attribute 

Remaining Attributes... 

(e.g., Data Attribute) 

SI Attribute includes timestamps  

generally referred to by OS. 

They can be modified by APIs (e.g., SetFileTime). 

FN Attribute also has timestamps but 

it cannot be modified by APIs. 

MFT record 

of the file 



Bonus Hands-on: Tracking 
Attacker’s Activities (Cont.) 

• Hints for Question1 
– Extract and check the timeline with FN 

timestamps 
• "C:\IIJ_Hands-on\WinHost\timeline\win7usp1-

current-with-fn\20120901-
win7usp1_bodyfile_with-fn.csv.zip“ 

– Search one of the tool names (e.g., “psexec”)  
• check the FN attribute timestamp 

– You can differentiate kinds of file system 
timestamp by means of type(G) column 
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hands-on 
Host OS 



Bonus Hands-on: Tracking 
Attacker’s Activities (Cont.) 

•Question2 

–Examine post-infection activities 

•Can you find “a.7z”? 

–Any other leaked files? 
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Bonus Hands-on: Tracking Attacker’s 
Activities (Cont.) 

• Hints for Question2 
– overwritten file meta data or securely deleted files 

• Restore files from Volume Shadow Copy 
– Windows Approach (Windows 7/Server 2008 required) 

» Convert the dd image to vhd format (image backup 
recommended) 

» vhdtool /convert <filename> 
» C:\IIJ_Hands-on\WinHost\tools\vhdtools 

» Mount the vhd image 
» “Attach VHD” in Disk Management 

» Check VSCs and export files 
» ShadowKit 

» C:\IIJ_Hands-on\WinHost\tools\ShadowKit_Portable_v1.5 

– SANS SIFT Workstation's Approach  
» Calculate the disk offset to mount 

» fdisk –lu <filename> 

» Extract VSCs 
» vshadowmount –o <disk_offset_value> 

» Check VSCs and export files 
» log2timeline-sift and TSK 

» The generated VSC timeline is located in "C:\IIJ_Hands-
on\WinHost\timeline\win7usp1-vss3\20120901-vss3-
bodyfile.zip" 
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The image will be  
overwritten without  
confirmation! 

Don’t run twice! 



Analysis in the Case 
• Timeline Creation 
• Root Cause Analysis of Malware Infection 

– Checking automatic start-up programs (Hands-on#1) 
– Identifying Malware Installation Time (Hands-on#2) 
– Timeline Analysis (Hands-on#3) 
– Analysis of Malicious Document File (Hands-on#4, Hands-

on#5) 
– Analysis of Shellcode and Malware 
– Result 

• Analysis of Post-infection Activities (Bonus Hands-on) 
– Investigating Attacker’s Activity 
– Analyzing Unknown Binary 

• Wrap-up 
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Timeline of the Incident 
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See the answer slide 



Wrap-up 
• Forensic investigation and malware analysis 

combination can clear  
– root cause of malware infection 
– malware type/functions 
– post-infection activities 

• Practical disk image is more chaotic  
– high-capacity disk, many unknown binaries 
– data loss over long term 
– evidence contamination by first responders 

• Free tools have reasonable functions, but commercial 
tools often work effectively 
– IDA Pro 
– EnCase/X-Ways Forensics 
– etc.. 

• IMPORTANT: delete the disk image after hands-on 
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Contact 
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E-mail: 
t-haruyama@iij.ad.jp 
hiroshi-suzuki@iij.ad.jp 
 
Twitter: 
@cci_forensics 
@herosi_t 
 



URL Reference 
• Forensic Analysis 

– OS 
• SANS SIFT Forensic Workstation 

– http://computer-forensics.sans.org/community/downloads 

– Timeline Creation 
• log2timeline-sift 

– blogs.sans.org/computer-forensics/files/2012/06/SANS-Digital-Forensics-and-Incident-Response-
Poster-2012.pdf 

– http://computer-forensics.sans.org/blog/2011/12/16/digital-forensics-sifting-cheating-timelines-with-
log2timeline 

– http://computer-forensics.sans.org/blog/2011/12/07/digital-forensic-sifting-super-timeline-analysis-
and-creation 

– http://computer-forensics.sans.org/blog/2011/11/30/log2timeline-plugin-creation 

• log2timeline  
– http://code.google.com/p/log2timeline/ 

• Adding $fn（$filename）attribute timestamps 
– http://list-archives.org/2012/07/10/dfir-lists-sans-org/log2timeline-vs-log2timeline-sift/f/4359338113 

– File System Analysis 
• Digital Forensic Framework 

– http://www.digital-forensic.org/ 

• TSK 
– http://www.sleuthkit.org/ 

– Checking Program Execution Cache 
• Prefetch Parser 

– http://computer-forensics.sans.org/blog/2010/02/12/prefetch-parser-v1-4/ 

• ShimCacheParser 
– https://github.com/mandiant/ShimCacheParser 

– Volume Shadow Copy Analysis 
• Accessing Volume Shadow Copies 

– http://windowsir.blogspot.jp/2011/01/accessing-volume-shadow-copies.html 

• Shadow Timelines And Other VolumeShadowCopy Digital Forensics Techniques with the 
Sleuthkit on Windows 

– http://computer-forensics.sans.org/blog/2011/09/16/shadow-timelines-and-other-
shadowvolumecopy-digital-forensics-techniques-with-the-sleuthkit-on-windows 

• ShadowKit 
– http://redrocktx.blogspot.jp/p/shadowkit.html 
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URL Reference (Cont.) 
• Forensic Analysis 

– Registry Analysis 
• Registry Decoder 

– http://www.digitalforensicssolutions.com/registrydecoder/ 

– Web History Analysis 
• IECacheView 

– http://www.nirsoft.net/utils/ie_cache_viewer.html 

• IEHistoryView 
– http://www.nirsoft.net/utils/iehv.html 

• Web historian 
– http://www.mandiant.com/resources/download/web-historian 

– Detecting Suspicious Auto-start Programs 
• Autoruns 

– http://technet.microsoft.com/ja-jp/sysinternals/bb963902.aspx 

– Disk Image Mounting 
• FTK Imager 

– http://accessdata.com/support/product-downloads 

• OSFMount 
– http://www.osforensics.com/tools/mount-disk-images.html 

– Event Log Analysis 
• Event Viewer 
• Event Log Explorer 

– http://www.eventlogxp.com/ 

– Image Format Conversion 
• qemu-img 

– https://access.redhat.com/knowledge/docs/ja-
JP/Red_Hat_Enterprise_Linux/5/html/Virtualization/sect-Virtualization-Tips_and_tricks-
Using_qemu_img.html 

• FTK Imager 
– http://accessdata.com/support/product-downloads 

• vhdtool 
– http://archive.msdn.microsoft.com/vhdtool 
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URL Reference (Cont.) 
• Malware Analysis 

– Observing process/file system/network 
• process monitor 

– http://technet.microsoft.com/ja-jp/sysinternals/bb896645.aspx 

• process explorer 
– http://technet.microsoft.com/ja-jp/sysinternals/bb896653.aspx 

• process hacker 
– http://processhacker.sourceforge.net/ 

• captureBAT 
– http://www.honeynet.org/node/315 

• API Monitor 
– http://www.rohitab.com/apimonitor 

– Checking difference after malware execution 
• regshot 

– http://sourceforge.net/projects/regshot/ 

– Network Analysis during malware execution 
• Wireshark 

– http://www.wireshark.org/ 

– Simulating internet servers 
• InetSim 

– http://www.inetsim.org/ 

• FakeNet 
– http://practicalmalwareanalysis.com/fakenet/ 
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URL Reference (Cont.) 
• Malware Analysis 

– Code Analysis 
• CFF Explorer 

– http://www.ntcore.com/exsuite.php 
• IDA Pro 5.0 Free 

– http://www.hex-rays.com/products/ida/support/download_freeware.shtml 
• OllyDbg 

– http://www.ollydbg.de/ 
• Immunity Debugger 

– http://debugger.immunityinc.com/ 
• libemu 

– http://libemu.carnivore.it/ 
• Malzilla 

– http://malzilla.sourceforge.net/ 

– Binary Editor 
• FileInsight 

– http://www.mcafee.com/us/downloads/free-tools/fileinsight.aspx 

– Javascript Analysis 
• jsunpack-n 

– https://code.google.com/p/jsunpack-n/ 
• Revelo 

– http://www.kahusecurity.com/2012/revelo-javascript-deobfuscator/ 
• Malzilla 

– http://malzilla.sourceforge.net/ 

– PDF Analysis 
• http://computer-forensics.sans.org/blog/2011/05/04/extract-flash-from-malicious-pdf-files/ 
• PDF Stream Dumper 

– http://sandsprite.com/blogs/index.php?uid=7&pid=57 
– http://blog.zeltser.com/post/3235995383/pdf-stream-dumper-malicious-file-analysis 
– http://www.kahusecurity.com/2011/pdf-analysis-using-pdfstreamdumper/ 

• peepdf 
– http://eternal-todo.com/tools/peepdf-pdf-analysis-tool 
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URL Reference (Cont.) 
• Malware Analysis 

– Analyzing MS Office documents 
• OfficeMalScanner 

– http://www.reconstructer.org/code.html 

• offvis 
– http://www.microsoft.com/en-us/download/details.aspx?id=2096 

– Flash Analysis 
• AS3 Sorcerer 

– http://www.as3sorcerer.com/ 

• SWFTOOLS 
– http://www.swftools.org/ 
– http://securitylabs.websense.com/content/Blogs/3165.aspx 

• SWFREtools 
– https://github.com/sporst/SWFREtools/ 
– http://www.google.co.jp/search?q=malicious+swf+analysis&ie=utf-8&oe=utf-

8&hl=ja&client=ubuntu&channel=fs 

• SWFInvestigator 
– http://labs.adobe.com/technologies/swfinvestigator/ 

– JAVA Analysis 
• jad 

– http://www.varaneckas.com/jad/ 

• jd 
– http://java.decompiler.free.fr/?q=jdgui 
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URL Reference (Cont.) 

• Exploit 
– CVE-2012-1535 

• http://contagiodump.blogspot.jp/2012/08/c
ve-2012-1535-samples-and-info.html 

• http://contagio.deependresearch.org/docs/
CVE-2012-1535-Adobe-Flash-Player-
Integer-Overflow-Vulnerability-Analysis.pdf 

• http://labs.alienvault.com/labs/index.php/2
012/cve-2012-1535-adobe-flash-being-
exploited-in-the-wild/ 

– CVE-2011-1249 (MS11-046) 
• http://www.exploit-db.com/wp-

content/themes/exploit/docs/18712.pdf 
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Book Reference 

• Forensic Analysis 
– File System Forensic Analysis 
– Windows Forensic Analysis DVD Toolkit 
– Mastering Windows Network Forensics and 

Investigation 

• Malware Analysis, Reverse-Engineering 
– Rootkits: Subverting the Windows Kernel 
– The Rootkit Arsenal 
– Malware Analyst's Cookbook and DVD 
– Practical Malware Analysis 
– IDA Pro Book 
– Reversing: Secrets of Reverse Engineering 
– Windows Internals 
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